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Introduction

Document layout is the process of combining text and graphics and
arranging them on a page. Today this process involves designing the
page, gathering the text and graphics to be laid out, and specifying
how the text should be typeset. After typesetting, the text and
graphics are arranged and pasted on a layout sheet by hand.

This functional specification for the Aldus document layout

system

describes how a user can electronically lay out documents on an

Apple Macintosh or Lisa computer by running the Aldus layout software.
It also describes how a user can send documents to be typeset in page
position. For the purposes of this specification, documents are
defined broadly. Examples of documents are reports, small brochures,
newsletters, and display ads.

Building documents interactively using the Aldus layout system

rather

than pasting down typeset text and graphics by hand results in

several benefits:

1

2)

3)

Time savings - the time required to construct a page is
reduced, since the amount of cutting and pasting is eliminated
or reduced. The Aldus layout software lets the full
capabilities of the output device (such as the typesetter or
laser printer) be used to set as much of the text and graphics
as possible in page position. 1In addition, production time is
reduced because the layout person can handle the entire
production cycle by himself rather than relying on others to
produce it from a paper layout.

Cost savings - labor costs are reduced because no specially
trained production staff is needed to produce the page from
its layout. Not only can the Aldus layout software be used to
electronically position the elements of a page on the
Macintosh or Lisa screen, it can also generate the commands
necessary to set the page (or most of it) in position on a
printer or typesetter. The person using the Aldus layout
system is not required to understand how to drive typesetters;
instead that job is relegated to the software, and the layout
person can concentrate on creating the best possible layout
without writing complex composition commands. Materials costs
are reduced because most of the page (if not all) can be set
in page position, thus reducing the amount of photographic
paper used.

Reduced error rates - errors become less likely, since the
layout person sees a representation of the page before it is
typeset and corrects potential problems. ‘

Production Scenarios

Figure 1 shows the production flow for a typical "cut & paste"
environment. Note that many different proof cycles are needed, since
production of the page is a separate activity from creation of the

page.

The layout artist sketches how the page should look, but must

pass this sketch on to a person skilled in typesetting for the page to
actually be produced. The resulting galleys of type must then be



integrated into a page by pasting the elements together. At each
stage of development, another person may be involved. If the final
page is to match the expectations of the page creator, the production
of the page must be carefully monitored by the creative person after
each step of production.

Figure 2 shows the production flow for pages created using the
Aldus layout system. In this case, the production of the page is
managed largely by the layout system. The layout system user sees the
page on the screen as it will be produced on the printer or
typesetter. As a result, the proof steps required to monitor the
production of the page are eliminated.

Advantages of Aldus Document Layout

The critical advantages of the document layout terminal are that
it --

o Allows the user to organize the many pieces that go into a
publication,

o Is integrated with other important tools, allowing the user to
use text files created by word processing programs and graphic
illustrations created by picture creation programs.

0 Allows the user to easily create page layouts by placing text
and graphic elements on predefined page formats. It then
allows the user to manipulate the resulting page for fit and
appearance.

0 Provides the user with a proof of the page before output to a
laser printer or typesetter.

Orientation of Aldus Document Layout

Because the layout system is a creative tool, the accuracy of the
display is very important. The display must show the document
accurately enough so that the user can make esthetic judgements about
the type and layout. Speed is also very important, but cannot take
priority over accuracy.

Typesetters don't always support everything users would like to
do, because they generally use characters as the smallest unit that
can be placed on the page. New generation typesetters and laser
printers, since they are digital devices, can place individual "bits"
(dots that make up a character or graphic) on the page, thus providing
flexibility limited only by the size of a bit. Since the bits in
these "bit-mapped" typesetters and laser printers can be from 1/300
down to 1/3000 inches square, graphic elements along with text can be
printed by these devices. The Aldus document layout system drives
these bit-mapped devices with everything set in page position.

If the Aldus layout system is being used to produce pages on a
typesetter, some of the functions the typesetter can't do must still
be possible with the layout system. For example, few typesetters can
set rotated text; typically, the text is set separately and pasted
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into the page. Aldus document layout lets the creative person
eliminate the paper layout by allowing him to place rotated text (and
other things not supported directly by most typesetters) into the
document. Once into the document, these unsupported functions are
emulated on the typesetter as best as possible; for example, the
rotated text could be output separately from the rest of the document
(in unrotated position) with instructions to cut and paste into place.

With this product orientation in mind, we now look at the
description of the Aldus layout system. The description is divided
into four major sections, one describing the overall flavor of how the
user interacts with the layout system, one discussing the composition
principles to which the layout system adheres, one showing the screens
that are presented to the user for each function, and a fourth
describing how other equipment, such as typesetters and printers, can
be used along with the layout system. 1In addition, two appendices are
included, one describing the algorithm that allows the user to place
text onto the page with the layout software making line end decisions
for him, and one showing an example of making up a simple display ad
using this system.



User Interface Principles

This section describes ways in which the user interacts with the
system, including how the screen is divided up, how the user works
with pieces of the document, how commands are invoked, and what the
user sees as he uses the functions described here.

In general, the user interacts with the system using a pointing
device called a "mouse", and a keyboard. The mouse is a small box
that rides on a roller, and can move in any direction on a flat
surface (such as a table top). A "cursor" is connected to the mouse,
so that as the mouse is rolled around the table top, the cursor is
moved on the screen. The appearance of the cursor can change, but it
is usually a small arrow (called the "pointer") that the user points
at things he wants to choose on the screen.

Screen Layout

The user is presented with different screens at different times,
depending on which tool is controlling the screen. When the Macintosh
or Lisa is first started up, the file system (the Finder) controls the
display. The Finder shows the user the "desktop," a representation of
the objects the user can manipulate. (A sample desktop is shown in
figure 3.) The user starts up the Aldus layout software by selecting
the icon that represents the layout tool (or by selecting an icon that
represents a document previously built by the layout software), and
opening it from the File menu. Once the user starts up the layout
software, the display is changed to the basic layout shown in figure
4,

The "document window" is the user's view of the document he is
working on. If the document is small enough (4.75 by 7 inches on the
Mac, 6.5 by 8.5 inches on the Lisa) and fits on a single page, the
entire document will be visible in the window. If the document is too
big to fit in the window or is several pages long, only a piece of the
document will be visible through the window at any time. The user is
able to move the window so that he can look at different sections of
large documents, or change the page display size to see a full page at
a reduced size.

The "scroll bar" is used to change what the user sees through the
document window. Since a full page may not fit into the document
window, the user can change which section shows through the window by
manipulating the scroll bar. The scroll bar is discussed in more
detail later.

Across the top of the screen appear several different menu titles
for the "pull-down menus". The pull-down menus are small boxes
containing lists of commands. The user selects a menu by placing the
cursor over a title and pressing the mouse button. When a user
selects a menu title, the menu "pulls down" over a portion of the
document window. It momentarily overlays the document window, just as
if a small piece of paper was unrolled from below the menu title onto
the document window. Once the user makes a selection, the menu
disappears.

The "tools bar" contains several small symbols that the user can
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select. These symbols allow the user to quickly switch between
constructing graphic elements and placing or editing text elements.
Each symbol corresponds to a method of interacting with the display.
For example, the tool for the construction of a line rule is used to
specify the end points of the rule.

Documents and Document Elements

Documents are the objects ultimately created by the layout
terminal. Documents may be one of two types, multi-page or single
page. The user will be able to decide how many pages are in each
multi-page document.

Multi-page documents can act much like sketch pads; they may be
used for trying alternate layouts for a particular newsletter page or
ad, and allow the user to quickly flip back and forth between these
different layouts. The user may try one layout on the first page, and
then flip to the second page to try something else.

Multi-page documents can also be the newsletter (or a section of
it) that the user is producing. Typically, the user builds a scratch
pad document for trying alternate layouts for each newsletter page (as
described in the previous paragraph), and then chooses the best layout
for each page and copies it to the publication document.

Single-page documents are used for two purposes: for documents
that the user knows will never be larger than a single page, and for
page formats. As a page format, single-page documents can be used to
quickly set up the overall "look" of a particular page. For example,
the user could build a single-page document with three columns and a
mast head, and then copy that page onto those pages in his publication
document that use that format. '

Organizing a Publication. The layout system user groups pages
together by placing the pages into a multi-page document. Also, the
user may use the Mac or Lisa Finder to collect documents together into
folders. For example, the user may want all of his newsletters
collected in a folder, or all the stories that will be run in the next
newsletter edition. Figure 5 shows a view of the Mac desktop with
several different folders (fillers, stories, ads, and art) and a
multi-page document named "newsletter." The folders may be opened by
the Finder to examine their contents, as is shown in figure 6 for the
stories folder. The newsletter document, which was created by the
Aldus layout software, can only be opened by that software.

Working Surface. The user can start up the Aldus layout software
from the Finder in one of two ways: by opening the layout tool itself,
or by opening a document previously created by the layout tool. If
the user opens a document previously created by Aldus layout, then it
appears on the screen exactly as it was saved. If the user opens the
layout tool itself, he is presented with a dialog box asking the user
for the name, number of pages, and page size for the new document.

The document pages may (at the user's choice) have a reference
grid laid over them (e.g., showing columns and inches), which the user
may use if he chooses to do so. When the grid is displayed, items the
user positions on the page are aligned to the grid; however, the user
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may turn off the display of the grid, thus giving him complete freedom
to place elements anywhere on the page. The user may change the grid
at any time without affecting elements that have already been placed
on the page.

If the user is working with a multi-page document, he may choose
any page to work on. The user moves from page to page by clicking the
mouse over the "page flipper" icon.

If the user is working with a single-page document, the page may
be called up and edited just as the multi-page documents are. The
only difference is that the single-page documents don't have a page
flipper icon for moving from one page to the next.

Elements are the contents of a document page. The following
sections discuss what elements the user works with, why element
selection is done before command selection, how elements are selected,
and how elements may be grouped together.

Kinds of Elements. The user may build or place the following
types of elements in a document using the Aldus layout system:

o0 stories - text of any length that the user chooses to treat as
a unit; they may have anything from one character to several
paragraphs of text in them.

o rules - lines (straight or free-form) or boxes with specific
thicknesses that the user may either typeset or just use on the
screen as an aid in designing his document.

o art - graphical elements created using compatible software
tools and pasted electronically into the document (the user may
not do anything other than cut, copy, or paste art).

Element First. Element selection is always done prior to command
selection, because the normal method of building a document is to work
with a particular element until it is right. For example, a paragraph
may have its typeface, character size, and line width changed before
the user is prepared to move on to the next paragraph. When the user
selects elements first, the same element can have an unlimited number
of changes made to it without being reselected.

Element selection first has another important implication: since
it doesn't make sense to do some things to some kinds of elements, the
currently selected element (if any) affects which functions the user
can do. For example, if the user has selected a paragraph, the
function 'Change rule weight' will not be selectable. Obviously,
some functions don't care what element is currently selected. An
example of a function that doesn't care is the one that creates a new
rule, since it "starts from scratch" rather than working with an
element the user has selected.

How Elements are Selected. The mechanism for element selection
varies depending on the element to be selected. Page design works
with two very different types of elements, text and graphics. The
user really can't do that much with graphic elements (except to build,




cut, copy, or paste them), but can do all sorts of things with text
elements. For example, a text element can have its typeface,
character size, and letter spacing all changed, and can be
left-justified, right-justified, centered, or flowed into an irregular
shape. As far as the Aldus layout system is concerned, text is much
more complicated than graphics are.

When dealing with text, the user wants three ways of making
selections: (1) he wants to select arbitrary pieces of text (for
example, the first three words in the third line of a paragraph); (2)
he wants to select a position somewhere so he can insert or delete
some text; and (3) he wants to select logical chunks of text (for
example, a story or a paragraph).

The user selects arbitrary pieces of text by pushing the mouse
button down, stroking the mouse through the desired piece, and letting
the button up. If the piece runs over several lines, the user need
only push down over the first character, drop down to the last
character, and let the button up. The system will then select all
text that falls between the starting and ending characters (including
the first and last characters).

The user chooses a point for the purposes of adding or deleting
text (an "insertion point") by positioning the mouse to the desired
point and clicking the mouse button once. The user can choose an
insertion point either inside some text that has already been placed,
or anywhere else on the sheet or page.

Selection of paragraphs is done by double-clicking anywhere over
the paragraph. An entire story (all text placed on the page together
via the "Place text" function) can be selected by holding down the
command key and double-clicking anywhere over the story.

Selection of graphic elements is much simpler: the user merely
makes a single click anywhere on the graphic element to select it. If
the user wants to select a group of graphic elements that are located
near each other, he may depress the mouse button at one corner of the
group of elements, drag the mouse to the opposite corner, and release
the button. As a result, all elements completely inside this box are
selected. Entire chunks of bounded text may also be treated as
graphic elements using this selection method.

The following chart summarizes how the user may select text and
graphic elements.

User wants to select So he does a

i
a text insertion point H click anywhere on the page
a paragraph | double-click over the paragraph
[
]
i
i

a story shift-double-click over the story
an arbitrary piece of text drag thru the text he wants
a graphic click over the graphic

text and graphics together drag selection box around elements

If the user wants to change any of the selections, he need only



select a new element and the old element will be deselected. 1In
addition, a click in the document window away from any element
deselects the current element (since it selects a new insertion

point).

Grouping. Elements may be grouped so that functions can operate
on the entire group at one time, rather than forcing the user to
perform the same function over and over again on several different
elements. Grouping may be done two different ways: (1) after the
first element has been selected, the user may add other elements to
the group by holding down the shift key while selecting other
elements; or (2) the user may depress the mouse button in the document
window, stroke diagonally to build a box containing all the elements
he wishes to group, and let the button up. Groups are strictly
temporary, and only last until another element is selected.

There are a couple of restrictions on grouping elements. First,
the user cannot select more that one contiguous chunk of text by using
the shift-select method, since several functions need a single,
unambiguous insertion point (more than one chunk means more than one
insertion point). The user can select any number of graphic elements
this way, but only one text chunk.

The selection box method of grouping elements allows the user to
select any number of graphic and text elements, but restricts the way
the user can work with the elements in the group. The user can only
treat the text in the selection box as a graphic, and thus may cut,
copy, paste, move, or rotate the elements in the box, but cannot do
any of the text manipulation functions. Furthermore, the user can
only have one selection box at a time.

Functions

This section discusses how the user chooses a function to operate
on the elements he has selected, how defaults for the functions are
handled, shortcuts available to the expert user, the 'undo' function,
and what help aids are available.

Choosing a Function. Any time the user wants to change something
in the document, he does so by selecting a function to operate on the
currently selected element(s). Function selection is done using
menus, the keyboard, or the tools bar.

The menu titles are displayed across the top of the screen, with
the menus appearing as pull-down boxes covering part of the document
window. The pull-down menus appear after the user has pressed the
mouse button down over a menu title. They disappear after the user
has made his selection from the menu by releasing the mouse button
over the menu item he wants.

Many of the functions on the menus are also accessible from the
keyboard. Those menu items that can be selected directly from the
keyboard have their keyboard code displayed next to the menu item in
the pull-down menus. As the user uses the system, he also learns
shortcuts to the menu system. Using the keyboard is functionally the
same as choosing the matching menu item from the menus.



The user can change the functions available to him by choosing a
different tool from the tools bar. The user must always have one of
these tools selected, since the current tool profoundly affects how
the user can interact with the display. The functions to create new
graphic elements can only be done when one of the construction tools
is selected from this bar. Similarly, the user can only edit text
elements if he has selected the edit tool.

The tools in the tools bar include an editing tool and a set of
construction tools. The editing tool allows the user to place text in
the document, select text and graphic elements in order to change
their attributes, and move or rotate elements. The construction tools
allow the user to build new graphic elements.

The following paragraphs show the icon for each tool and describe
the functions that the user can perform while that tool is active.

tomm——— + The user edits text by simply pointing to the insertion

| i point, clicking the mouse button, and typing at the

! R‘ | keyboard. The following editing functions are supported:
Fommmm +

Start editing. Editing always begins with the user pointing
to the place where he wants to begin editing and clicking
the mouse button. A vertical bar is displayed at the
insertion point.

Delete characters. The user deletes characters to the left of
the insertion point using the keyboard backspace keys.

Insert/Overstrike. The user replaces existing text by
selecting the piece of text he wants to overstrike and
typing in the new text. The selected text is deleted
once the first character is typed, and the new text
placed at the location where the deleted piece used to
be,

Stop editing. At any time during editing the user may move
the cursor using the mouse. This does not affect the
location of the insertion point unless the user selects
another element or another function. As soon as another
element or function is selected, the insertion point goes
away.

Menu functions. All of the functions in the menus are
available while this tool is active.

= + Create line rule. When selected, the cursor shape changes

H | to the graphics cursor, and the user is expected to press
\ 1/, 1 the mouse button at the first rule endpoint, drag the
o= + cursor to the second endpoint, and release the button.

- As the user drags the cursor towards the second endpoint,
the system draws a line from the cursor back to the first
endpoint so that the user can see how the line would look
if he released the mouse button. The user is able to
constrain the rule to being either vertical or horizontal



by pressing the shift key while drawing the rule. The
current rule weight is used.

graphics cursor, and the user is expected to indicate two
opposite corners of the box rule by pressing the mouse
e + button at one corner, dragging to the other corner, and
releasing the mouse button. As the user drags the cursor
from the first corner to the second corner, the system
draws a box between the two corners so that the user can
see how the box would look if he released the mouse
button. The user is able to constrain the rule to being
a square box by pressing the shift key while drawing the
box rule. As before, the current rule weight is used.

+ Create box rule. The cursor shape again changes to the
]
|
1

o m——— —+ Sketch. Selection of this function makes the user's mouse
:l H into a pencil; in fact, a pencil-shaped cursor is used to
H Z? | indicate to the user that he using this function. The
=t user sketches by pressing the mouse button and dragging

the cursor around the screen. When the user lets the
mouse button up, the cursor no longer sketches. The user
may 1ift the pencil up and down as many times as he
likes.

Autowrap/Composition. The system wordwraps (i.e., breaks
paragraphs into lines) and composes text as it is edited, according to
the margins and type characteristics in effect around the text edit
point. An important choice that the user must make deals with whether
or not text is affected by other elements on the screen as it is
placed in the document. Sometimes the user wants text to flow into
columns, for example, or between two guides. Other times the user
Just wants the text placed on the sheet or page without regard for the
other elements already there. Thus, one of the functions in the
Styles menu controls whether or not text flows against other elements
when it is placed on the sheet or page.

When the user chooses "Flow on", text that is being placed is
filuid. The user is shown (using a stipple pattern) the area around
the insertion point that the text will flow into. The user has the
option to either begin typing in text or selecting "Place text file"
from the File menu. The text flows so that the text stays within the
bounded area. If the user changes the borders surrounding text that
has already been placed and wishes to reflow the text, he must
explicitly do so from the Styles menu. An example of flowing text
onto the page is given in appendix A.

Adaptive Defaulting. Defaults are provided for most function
parameters; for example, if the user builds a horizontal rule, he does
not need to specify a rule thickness unless he wants to. Changes that
the user makes to the parameters (e.g., rule thickness) are stored by
the system and made the new defaults. Thus, the user, returning to a
command, will find the default values to be those he last entered when
using that command. \

Serolling. A scroll bar is always displayed below the tools bar.
The scroll bar is a small representation of the current page or sheet,



with a box representing the current document window overlayed on the
page. The user changes the current view of the page or sheet by
grabbing the window box with the mouse and dragging it to another part
of the page. Since the window may be only crudely placed by this
technique, the user will also be able to scroll the window by pressing
the option key on the keyboard while dragging the mouse on the screen.
When the option key is pressed, the cursor shape will change to a
small hand, reminding the user that as he drags the cursor, the window
will be scrolled.

In addition to scrolling when the user moves the scroll box or
uses the option key, the window scrolls automatically whenever the
user attempts to drag the cursor out of the document window (e.g.,
while constructing a rule, or selecting something by dragging the
cursor over it). Merely moving the cursor out of the window without
holding the mouse button down will not autoscroll.

If the user is working on a sketch pad (rather than a page), a
small icon called the "page flipper" is displayed below the scroll
bar. The user moves from page to page by clicking the mouse button on
this icon. The page flipper icon is split diagonally; clicks over the
upper half advance to the next page in the document, and clicks over
the lower half back up to the previous page in the document.

Undo Function. An 'undo' function is provided for rejecting the
last change made to the document. If, for example, the user
incorrectly places text in the document window, the undo function will
remove the placed text and give him another chance. If the user
undoes an undo, the original change to the document reappears. The
undo menu item includes the name of the command that it will undo if
chosen by the user.

In addition to the undo function, a replay file is kept of all
user actions. This replay file is capable of driving the system by
itself, and thus is usable for tutorials and documentation of bugs.
The user starts and stops recording or replaying his actions from the
'tools' menu. The replay files may not be edited by the user.

Moving and Rotating Elements. The user may move or rotate text
or graphic elements by either of two ways: (1) surrounding the
element(s) using the box selection method and interacting with the
selection box; or (2) directly interacting with graphic elements.

The user may move a graphic element by placing the pointer
directly on the element and dragging it to its new location. The user
may select a group of graphic elements (using the shift-select method)
and drag all of them together by pointing at one of the elements and
dragging it.

The user may move all elements that are completely inside the
selection box (including text) by pointing to any box edge and
dragging the box to the new location (the cursor changes to a sky hook
shape when the user presses on the box edge). Holding down the shift
key while moving the box and its contents forces the move to be
strictly vertical or horizontal, depending on the direction the user
first starts moving.



The user may rotate all elements inside the selection box by
pointing to any box corner and dragging the corner in a circular
motion (the box center is stuck to the paste-up sheet). When the user
presses the mouse button over the box corner the cursor changes to a
double~headed curved arrow. Holding down the shift key while rotating
the box and its contents forces the rotation to jump in 45 degree
increments.

Help Files. A help file is available for each user function,
which contains a concise description of how each function is used. A
help menu item is available in the anchor menu and is accessible at
any time. Choosing the help function causes the help information for
the current mode to be displayed in a pop-up window. The user gets
rid of the help window by clicking in the window's close box.

Cursor Shape.

Several different cursor shapes are used to help indicate how the
system is interpreting user input:

o arrow - shape used anytime the cursor is located outside the
document window; also used inside the document window when in
edit mode and not inside a text element.

o I-beam -~ shape used when the cursor is in edit mode and inside
a text element in the document window.

o cross - shape used when the cursor is in the document window
and the user is in a construction mode, except for sketch
mode.

0 pencil - shape used when the cursor is in the document window
and the user is in sketch mode.

o hand - shape used when the user presses the option key;
dragging the hand scrolls the window over the sheet or page.

0 sky hook - shape used when the cursor is in the document
window, the user is in edit mode, and he is pointing at the
edge of a selection box in an attempt to move the objects
wholly inside the box.

o curved, double-headed arrow - shape used when the cursor is in
the document window, the user is in edit mode, and he is
pointing at the corner of a selection box in an attempt to
rotate the objects inside the box.



Composition Principles

The following section describes the general principles governing
the composition techniques that are part of the layout software.
Composition is the process of setting type; for the Aldus document
layout terminal, the techniques are specialized to fill areas on the
page with type in a pleasing manner, rather than just filling galleys.

Area composition is central to the Aldus layout system. Our
primary objective is to eliminate the production of pages from paper
layouts, as must be done if the composition system can only set
galleys of type. Using the Aldus system, the electronic layout the
page creator designs on the Mac / Lisa screen is directly typeset with
everything on the screen set in page position.

Objectives

The composition subsystem has the following objectives, listed
here in order of importance:

1. Ease of use. The composition subsystem is largely hidden from
the user. Our users are not typographers; they do not want to
learn a composition language or even many composition
principles in order to use the layout terminal. Our users are
expected to be familiar with the principles used by a typical
word processor, and no more,

2. Performance goal. The composition subsystem is fast enough to
compose and display an 8.5 by 11 inch 2-column newsletter page
containing approximately 8000 characters in four seconds.

This means that the composition subsystem can process
characters at a rate of about 2000 characters per second.

3. Accuracy. The composition subsystem places characters on the
page as accurately as possible so that possible conflicts can
be recognized immediately.

4, Hyphenation. The composition subsystem offers a hyphenation
scheme that results in as few hyphenation errors as is
practical. An exception dictionary is provided to cover cases
where the algorithm is unable to correctly break a word.

Users can add their own words to this dictionary to decrease
the annoyance of having words incorrectly hyphenated.

Features

To support the objective of an easy to use system, the complexity
of the composition subsystem is hidden from the user. Most of the
composition subsystem operates automatically, using values and methods
that best fit the current situation. For example, details of
hyphenation, such as the minimum number of characters in a word before
or after a hyphen, are not controlled by the user.

Hyphenation. A small exception word dictionary is supplied along
with an algorithm for handling most cases. The dictionary supplied by
Aldus contains about 350 words. It can be expanded by the user to




approximately 1000 words, depending on available memory.

For future enhancements, additional hyphenation algorithms and
dictionaries can be added to support foreign languages. It will be
possible to compose more than one language in a single document.

Another future enhancement, given additional computer resources
(particularly memory and hard disk), is a large (100,000 word)
dictionary. This dictionary also may be modified by the customer, and
will be used for both hyphenation and spelling checking.

Justification and Line-breaks. The primary objective of the
justification algorithm is good performance, followed by pleasing
appearance of the text. The algorithm considers only one line at a
time, and once a line-break decision has been made, will not
reconsider it. No attempt is made to redistribute words in a
paragraph to minimize the differences in inter-word spacing throughout
the paragraph.

In general, the line-break algorithm attempts to justify a line
using the optimum inter-word spacing. If it fails, it tries
inter-word spacings between the minimum and the optimum values,
followed by spacings between the optimum and the maximum values. If
it still cannot justify the line, it tries altering letter-spacing
values in the line (again within a permissible range of values). If
changing the letter spacing does not justify the line, it tries to
hyphenate the last word on the line. If all these attempts fail, then
the algorithm exceeds the maximum values allowed for word and letter
spacing so that the line is justified.

A different algorithm is used to set ragged (non-justified) text.
It also provides good performance and a pleasing appearance for ragged
text.

Flowed Text. Text can be composed (flowed) into not only areas
with rectangular shapes, but also into areas with arbitrary convex
shapes. This is useful for display ads -- flowing text around artwork,
for example, and also useful when a distinctive appearance of text is
desired.

Typefaces. Actual typefaces (described by their outlines) are
displayed on the screen whenever the character size is larger than a
pre-defined switch-over point (probably around 12 to 18 point
characters). Below the switch-over point, bitmapped, generic
typefaces (supplied by Aldus) are used. The generic typefaces include
roman, italic, and bold faces.

As a minimum, eight different typefaces can be used on a single
page. When more typefaces are required, more can be added if computer
resources permit.

Character width information for Aldus-supplied typefaces are
delivered with the layout terminal. Width information for customer
typefaces must be entered manually by the customer.

Unit of Measurement. The composition subsystem uses the micron
(one-millionth of a meter, or one-thousandth of a millimeter) as its




basic unit of measurement. The units of measurement are stored as
signed 32-bit integers, so that more than two kilometers at one-micron
precision can be represented internally. One point is almost exactly
352. 777777 microns; we round up to 353 microns. In a 50-pica line,
the possible error is about 0.38 points (211,666.6667 actual microns
versus 211,800 computed microns).

The external composition units, those visible to the user, can be
anything convenient to the user, including inches, points, picas,
didots, ciceros, centimeters, and millimeters.



Functions and Their Screens

The following several pages show the screen layouts for each
function included in the first release of the software. Following
each screen layout is a brief description of what the function does,
including any actions the user has to take to perform the function and
any actions the user can't (or shouldn't) take.

Before proceeding to the first screen, however, some general
terms used in this document need to be tied to specific symbols and
locations on the screen (see figure 7). First of all, the distinction
between windows and dialog boxes needs to be made.

Windows are a means by which the user can look at a document.
The two main windows used by the layout software are the paste-up
window and the help window. The paste-up window shows the user a view
of the document he is producing, and the help window provides
information about each function in the system. Windows can be opened
and closed by the user.

Dialog boxes are objects that temporarily overlay a window, and
are used by individual functions to get more information from the user
or confirm a user action before proceeding with the function. For
example, the function to change character spacing has several options
by which the user may specify the new spacing, and uses a dialog
window to present the options to the user. Once the function is
complete, the dialog window disappears. Dialog boxes are completely
under the control of the function that put them on the screen; they
may not be manipulated by the user except to respond to specific
options presented in the dialog box.

Dialog boxes may present options to the user in several different
ways, including the opportunity for the user to type in something, or
to manipulate controls. Controls are graphic objects that cause an
action to take place when manipulated with the mouse. The controls
used in the dialog boxes include buttons, check boxes, and dials.

Buttons are small objects labeled with words or a symbol.
Clicking a button performs the action described by the button label
instantly. For example, if the user wants to do an irreversible
function, the function will bring up a dialog box warning the user
that the function is irreversible and require the user to verify that
he really wants to do it (by clicking an " OK " button) before the
function is allowed to proceed. Some buttons may also be pressed
(rather than clicked) to perform an action continuously.

Check boxes are used by dialogs to allow the user to set various
states, rather than perform instant actions. Check boxes are small
squares accompanied by a word or symbol that describes the meaning of
the box. The boxes may contain a check mark showing that the state
indicated by the text is set. Clicking in a check box flips its state
from checked to unchecked, or vice versa.

A variant of the standard check box is a collection of check
boxes with some relationship to each other. For example, perhaps only
one box out of a collection of alternatives can be checked at a time.
In this case, the check boxes can be set up to act like car radio
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buttons, so that when the user checks one box, all the other boxes in
the collection are unchecked automatically.

Dials are used to display a value assigned to something and to
allow the user to change the value by dragging the dial indicator.
For example, the scroll boxes in the scroll bar are dials, since they
show the current position of the window in the document, and can be
dragged to a new position by the user with the mouse.

With this basic understanding of the terms, we now look at the
specific displays and dialogs for each function.
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Function description. telils the user what version of the Aldus
layout software he is running.

User steps: The user gets to this screen by pulling down the

anchor menu and selecting the "About Aldus layout " menu

item. When the user is done looking at the dialog box, he
clicks over the "OK” button.
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Function description  tells the user about the documernt he
currentiv has ooen

vy

Jser steps The user gets to this screen by puiling down the
anchor menu and selecting the "about document " meny
item The user may not change the contents of any of
the f1eids When the user 15 done looring at

thus window, he closes 1t by clicking 1n the close box o1
selecting the close command from the file menu

Caveats A document must be open on the screen in order to
access this function
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Function description: allows the user to retrieve help
information for all the functions provided by Aldus.

User steps: The user gets to this screen by pulling down the
anchor menu and selecting the "Help. " menu item. Once
this window 1s displayed, the user may either select one of
the tools on the left side or one of the menu tities on
the right side of the window. In either case,

a dialog box will appear containing help information

specific to the item the user chooses (see next screen) The
user leaves the help window by ciicking on the help window
close box.
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Function descriptton’ allows the user to retrieve help
information for ail the functions provided by Aldus

User steps The user ge t; 0 this screen by pulitng down the

or menu and selecting the "Heip " menu ttem, followed
100sing the "Edi t menu title  Similar dialog boves
ppear for each menu and each 0ol The User may
now select one of the menu 1tems, and a new dialog box
wiil appear with information specific to that menu ttem
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Menu. description: contains the menu items necessary for
pulling documents into Aldus layout, printing them, and
writing them back to the disk. In addition, there are
functions for reverting to the previous version of the
current document, and for quitting Aldus layout.

User steps: The user gets to this screen by placing the pointer
| over the "File” menu title and pressing the mouse button.
| The user may either move the pointer over one of these
menu items and release the mouse button (thereby selecting
l the item) or pull the pointer outside of the menu and release
the mouse button (thereby not doing anything).
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Jser steps. The user gets to this screen by seleq Hng New
document” from the "File” menu. Once here, the user must
type in a document name and may choose to specify the

page size alsu (a default will be provided) Once the user 13

ge
atisfied with the contents of the dialog box, he clicks the
i "OK" button to begin iavout on the new document
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1) double-clicking on a document name,
1) typing the name into the prompt line and clicking on
the "Open” button ’

Caveats Support for multiple disks 1s now done through the
erect and drive buttons, but will be changed when Apple
changes their support for multinle disks
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Function description: saves the current document with the name
specified by the user but does not exit Aldus layout.

User steps: The user gets to this screen by selecting "Save

as.."from the File menu. Once here, the "Name”™ prompt
line will contain the old name of the current document (if it
has been previously saved). The user may either save the
document under its old name by just clicking " OK °, or he
may type in a different name and then click "OK ". If the
user wants to save the document on a different disk than
the one currently in the drive, he may choose “Eject” or "Drive.
"Eject” will cause the system to eject the current disk and wait
for the user to insert another disk. Once the new disk is
inserted, the same dialog box will appear for the new disk.
“Drive” will allow the user to save the file to the external disk,
if one exists.

The user may save the current sheet only as a format
by checking the “one-page format” box; otherwise, the
entire pad is saved.
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Function description: Adds a sheet to the currently open pad

by duplicating another sheet or a format, or by starting
with a clean sheet.

User steps: The user gets to this screen by selecting "Make new

sheet ..." from the File menu. Once here, the user may
choose what is to be on the new sheet initially by selecting
one of the checkbozxes, or he may take the default. If he
selects either "duplicate from a sheet in a different pad™ or
"duplicate from a format™ he will be prompted to select the
pad or format by the standard file open dialog.
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Function description: lets the user send the current page
to the proof printer.

User steps: The user gets to this screen by choosing "Proof print”
from the "File” menu. While the document is being printed,
the only action the user can take is to click "Cancel.”

The proof printer will print the page at full size. If the page
| is too large to fit on a single proof printer page, the proof
J printer will automatically strip the page into sections that
can fit on a page.
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Menu description: contains the Macintosh standard editing
functions for deleting, moving, and copying text or graphic
elements, plus functions for selecting or cutting story parts.

User steps: The user gets to this screen by pressing the mouse
button down while the cursor is over the Edit menu title.
The user may now move the cursor down over one of the
menu items and release the mouse button, thereby selecting
that menu item, or move the cursor away from the menu and
release the button, thereby not selecting anything.

Caveats: Undo will not be selectable if the last operation cannot
be undone. Cut and Copy will not be selectable if no element
is currently selected.
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Function description: works just like the normal "cut” command
except that the text in the “to text” line is inserted before the

cut point, and the text in the "from text” line is prepended to cut
text on the clipboard.

User actions: The user can fill in both, one, or none of the jump
text lines. If one or both of the jump text lines is blank, a blank
line is not appended or prepended around the cut point.

The “jump text” is in the same character size as the cut
text, but can be in a normal, bold, or italic typeface.
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Menu description: contains several functions for changing the
appearance of text and graphic elements, including the typeface
used to display text, its size and spacing, and rule
weights. In addition, the functions that control flowing of
text are on this menu.

User steps: The user gets to this screen by pressing the mouse
butten down while over the Styles menu title. Most of the
items in this menu lead W dialog boxes (shown on succeeding
pages), except for the flow functions.

"Flow on” changes the way new text 1s placed into
the document (see discussion 1n "Place” funcion). "Reflow”
allows the user to low the selected text against the elements
tordering it. Reflow is only selectable when flow mode
1son "Flow lorward” places text from the top left of the
current hele; "Flow backwards” places text so that the text
ends in the bottom right corner of the current hole
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Function description. lets the user either find cut what face
15 currently being used to display the selected text, or wo
change the face for the selected text and subsequent text

User steps: The user gets to this screen by selecting "Typeface. "

from the Styies menu. The user may choose a new face by
clicking in its box or scroil the typeface menu using -tne
vertical scroll bar. Once a face is selected, the user mus

either choose the " OK " button or the "Cancel” button to ieave
this dialog.



Indents ..

Filte Edit FITIXY Tools Justify 2oom
CEC Sample doc

O Indent the first line 4
of the paragraph(s).

O ?lnderit every line of the
" ‘paragraph(s) except
- the first

O Indent each|succeeding line ;
: of the paragraph

according to placement |

of the edit point. |

Cancel all indents in the selected :

LAY 4 FEVAEBAAY R L

o]
()
: tent :
K (Cancel) (Ok) |

Function description. lets the user specify indentation for the
selected text

User actions The user gets to this screen by selecting "Indents
from the Styles menu. At this point, he may choose any
of the indent styles shown above Indents are defined
by the distance from the left margin to the indent marker
on the herizontal ruler. The selected text need not have the
same left margin as 1s shown on the ruler
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Function description: lets the user ejther see what thickness
the currently selected rule is, or to change the thickness
of the currently selected {and subsequently created rule(s).

User csteps: The user gets to this screen by choosing "Rule
thickness” {rom the Styles menu. The user may choose
any of the rules in the window or type in a rule thickness.
The user exats from this dialog by selecling either the
"OK" button or the "Cancel” button. Dashed rules are built
by choosing the last box in the dialog.
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Function description  lets the user change the amount of white
space between characters

User steps The user gets to this screen by choosing
"Letter spacing " from the Styles menu. The user may
change the letter spacing value by dragging the pointer icon
along the scale, or by clicking in the value box and typing in
a new value The text can be displayed at actual size or at
enlarged size, so that the user can more eastly see the effect
that the letter spacing has on the selected text The user
exits this function by clicking either the " OK " button or
the "Cancel” button.

Caveats. This function is not available if

-no text 15 selected,
- justified text 1s selected, or
-more than one line i1s selected
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Function description: lets the user insert leader characters at
the current edit point Multipie copies of the chiaracter(s) are
inserted in this line untii the right margin and left margins
are encountered, or until guides or rules are enicountered.

User stePs: The user gets to this screen by choosing "Insert
leader” from the Styles menu. The user may choose either
the blank or period leader character by clicking on one of
the two boxes, or may type in one or more other characters.
The user exits from this function by clicking either "0K” or
“Cancel”.
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Function description: lets the user either see what the
current character and line spacing 1s for the selected text,
or change the character and line spacing for the selected and
subsequent text

User steps: The user gets to this screen by selecting

“text size / line spacing” from the Styles menu. To select

a character size, the user points to the desired size and ciicks
Line spacing 1s ¢chiogen based on character size The user can
choose a different line spacing by typing it in or clicking over
a different one in the window. Changing the character size
f1t adjusts the size so that the seiected text fits between the
margins on the horizontal ruler. Changing the line spacing

to fit adjusts the size so that the selected text fits between the
margins on the vertical ruler. Automatic line spacing will
determine line spacing according to the sizes of characters

in the current and previous lines.




Tools Menu

I _File_Edit_styles JEETITR Justify 2oom

Show ruters

::

Measurement system...
Reference grid...
Column guides...

Square story
| Start journal
Replay journal...

AXEGAILAGR R L TRXFLE

LEIXEG

Menu description: contains tools useful for laying out the page
form, including a pair of rulers, a selection of grids,
a guide builder, a function to square the legs of a story,

and a capability for capturing and playing back user actions.

User steps. The user gets to this screen by placing thie pointer

T over the Tools menu title and pressing the mouse button
I the rulers are currentiy displayed, then the menu item
akove will read "Hide rulers”, so that when it 1s selected
the rulers wnll disappear (and vice versa). Similarly, if
journaliing is currently turned on, then the menu item
will read "Stop journal,” and vice versa.
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runction description: brings up a pair of rulers that the user
g> UM
e in the document

User steps: The user gels the rulers on screen by chinosing

~ "Show rulers” from the Tools menu. The measurement
system shiown on the rulers can be changed by clicking on
a different check box on the horizontal ruler The user
can position this ruler pair anywhere in the document by
dragging it with the mouse. The user gets rid of the rulers
by selectng "Hide rulers” from the Tools menu
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Function description lets the user see the current measuremen
system or change to a different system.

User steps: The user gets to this screen by ¢choosing
‘Measurement system..” from the Tools menu The checked
box shows what measurement system is in effect. The user
may click on a different box to change measurement
systems The chosen measurement system 1s used for
all functions where the user may specify a measurement
by typing tn a value, or where a measurement is displayed
to the user The ruler measurement system 15 specified
separately (directly on the ruler)
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Function description lets the user quickly build guides for the

User actions: To buuid guides, the user enters the number of

&
right sides of the selected area, the margin 1s half the width
speciiied in the dialog. The third query asks {or the ¢ffsets
from the left and right edges of the page Cften, different
for left and right hand pages Selecting
‘Remove guides .. " causes the guides to be removed from
the selected area.
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Function description: lets the user replay a file containing a
previously saved sequence of user steps.

User steps: The user gets to this screen by choosing "Replay
journal” from the Tools menu. Only one replay file can
exist on a disk, so no name specification is needed. The
user may either type in the number of steps he wants
from the replay file, or let the replay file run without
specifying the number of steps (by leaving the field
blank) and stop the replay by using the

‘ ‘ “command-period” key combination.
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User steps: The user gets to this screen by pressing the mouse
T butlton while over the justify menu title None of these
functions have dialog boxes, each takes effect immediately.
The pointer, used to place elemnents on the page, clianges
crientation depending on which of these funclions have been
selected. If "Flush left” is selected, the pointer points ieft
If "Flush right” 1s selected, the pointer points right  If
‘Center” 1s selected, the pointer points up. If "Fill to
margins’ 1s selected, the pointer points left (just as if
"Flush left” had been selected)
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Menu description: contains functions for changing the scale

used to display the document

ser gets to this s<reen by pressing the mouce

: ons The u
button while over the Zoom menu title A’l tre functions
+

1 take effect immed:iately  All of the ratios shown
here T linear measures (the scale factor for the areas
1S the square of the linear factor). The center of the screen

u
’D
-0.

will be {1xed for all the scale factors except the "Fit on screen”

scale factor. When the "Fit on screen” function 1s chosen, the
center of the sheet or page becomes the center of the screen

Caveals. The only way to get the original center of the screen

vack after doing a "Fit on screen’” 15 to do an "Undo”



Aldus Document Layout Terminal Environment

This section describes the hardware on which the Aldus layout
software runs and the way typesetters and printers built by different
manufacturers are supported.

Hardware Configuration

The first version of the Aldus layout software runs on the Apple
Macintosh and Lisa personal computers. The decision to use the Apple
computers was based on the responsiveness and quality of the display,
along with the user interface philosophy. Of all of the mass market
micros available today, the Macintosh and Lisa are the most
appropriate to the interactive layout application.

The minimum configuration required to run the Aldus publication
system is a Macintosh with keyboard, mouse, and a minimum of 800 KB
disk storage, (see figure 8). A 400 KB version is provided for sales
& demo purposes. However, because of the limited file space, the
sales & demo version is limited in the number of screen fonts
available, and in the amount of document storage.

Connections to the output device (typesetter or laser printer)
will be through the "modem" port. Either a direct (RS 232C)
connection or a modem may be used.

The Apple Imagewriter is supported as a proof printer.

An external disk drive can be used with the Macintosh. A

Macintosh with a 400 KB internal disk drive requires a second Apple
external disk drive.

Software Configuration

The Aldus layout software can be changed to meet the specific
needs of each user. A default configuration is provided to meet the
requirements of the market segment in which the system is sold.

The configuration philosophy is to make options easy to install,
and change. Options exists as separate files that are added or
deleted with the Finder (see figure 9). The option files need only be
on the application disk; the layout software will recognize and use
them. The user modifiable options are the screen fronts, character
attribute and width tables, and the output device resource.

Fonts. Aldus supplies a default set of eight generic screen
fonts; serif and sans-serif in normal or bold, and Roman or italic.
Additional screen fonts created by typographic designers may be
purchased from Aldus.

These screen fonts are intended to represent as closely as
possible the printing fonts. However, because of the limited
resolution of the Macintosh screen, it is impossible to represent the
fine details of many type faces. Similar looking printing fonts will
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be represented with the same screen font.

Each screen font is in a separate file that can be added or
deleted with the Finder. Each screen font must be associated with one
or more printing fonts. This association is made in the character
attribute and width table (CAWT).

Character attribute and width tables (CAWIs) For each printing
font there is a CAWT. The CAWT is a table of information about the
characters in the font. It lists character widths, typesetter codes,
kerning pairs, and ligatures. The CAWT also tells the system which
screen font should be used to represent the printing font.

Aldus supplies a starting set of CAWTs for each of the laser
printers or typesetters supported. Additional CAWTs may be purchased
from Aldus or entered by the user.

Each CAWT exists as a separate file that can be added or deleted
with the Finder. The name of the CAWT file is the name of the font,
and is the same name that the layout software will use in the menu of
fonts.

A CAWT editor is provided for creating or modifying CAWTs. It is
capable of reading CAWT information from typesetters (when supported
by the typesetter).

Output devices. The layout software is capable of driving
different output devices (several typesetters, laser printers, and
proof printers). Each particular output device has a device driver.
These device drivers convert a document from layout software format to
output device format. The device driver for the output device in use
must be on the application disk. When more than one device driver is
present, the layout software will ask the user through a dialogue box
which output device to use. The device drivers can either create an
output file, or drive the output device directly (as in the case of
the proof printer). The configuration of the device drivers is
controlled by a dialogue box within the layout software application
program.

Interfaces

Input. The Aldus text editor is intended only for minor changes
to text inside documents, and not for original entry of text to be
used in the document. Instead, text is captured either by a third
party text editor such as Apple's MacWrite or Microsoft's Word, or by
a communications program. The layout software reads the "Text Only"
documents created by these editors (the user must specify this
document type). Except for carriage return and tabs, all formatting
information is ignored.

Text may also be merged with a document using the "clipboard."
The layout software is completely compatible with the Macintosh copy,
cut, and paste paradigm.



Output. The interface to the output devices is either through an
RS-232C connection or through a modem. The data format will be the
output device format.

Some typesetters, such as the Compugraphic series, use an eight
bit code. The Macintosh can transmit eight bit code so a direct
connection to Compugraphic systems is possible. However, many
communications facilities are set up for seven bit ASCII code. In
this situation, an eight bit to ASCII protocol is used, but the
underlying data format will still be that of the output device. The
user will specify through a dialogue box which format to use.

Communications. No communications programs are provided by
Aldus. The Apple program "MacTerminal" is used to handle all
transmission and reception of data. This program is flexible and can
handle seven or eight bit data at all the standard speeds from 300 to
9600 baud. MacTerminal also supports the Apple auto-dial modem.

To transmit typesetter files, the user contacts the typographer's
computer using MacTerminal, and enters a dialogue. When the computer
is ready, the user instructs MacTerminal to transmit the files.



APPENDIX A

This appendix contains a more detailed description of the
"autoflow" algorithm used to place text on the page. This algorithm
capability is most useful for placing stories on a page that is broken
into columns, but can also be used to put chunks of text inside an
odd-shaped area in a display ad.

The autoflow algorithm is intended to place text correctly 90% of
the time for typical newsletter pages. Thus, it is optimized for
placing text in columns broken by an occasional headline, photo, or
graphic. Other page layouts can be at least partially accommodated,
although we expect the user to manually place overset text for these
less structured cases.

Simply stated, the autoflow algorithm fills the current column,
jumping over boxed areas until it hits a blocking rule or guide, and
then looks to the next column to the right and repeats the process,
until its text supply is exhausted. The algorithm is shown below in
'Pascalic’'.

current hole := area surrounding Insertion Point;
WHILE there is a current hole DO BEGIN

REPEAT
fill the current hole;
IF blocking element is a box THEN
move past it and make the new area the current hole;
UNTIL the current column is blocked by a line rule or guide;

move the insertion point across the column guide to the right;
look above the insertion point for a blocking line rule or guide;
look below the insertion point for a blocking line rule or guide;
call the bounded area (if one exists) the current hole;

END; { WHILE there is a current hole }

The column guides that govern the algorithm are different from
the rules and guides that the user builds directly. Column guides
come in pairs, and are separated from each other by gutters. The user
builds column guides using the "Create column guides" function from
the Tools menu. This function asks the user how many columns the user
wants, how wide the gutters should be, and whether there should be an
offset from the left or right edge of the paper.

The autoflow algorithm works by filling "holes" with text. A
hole is defined to be the area surrounding the insertion point
completely enclosed by rules, guides, and the edges of the page. The
text placed into a box rule or guide, or against a line rule or guide,
does not butt up against the rule or guide; instead, it stands off
half the gutter width.



Once the current hole has been completely filled with text, the
algorithm looks for a new hole if it still has text to place. It
looks below the current hole in the current column, jumping around
boxed rules or guides, until (1) it finds a hole, or (2) it hits a
line rule or guide that blocks the column. If it finds a hole, it
makes it the current hole and repeats the filling process.

If the algorithm cannot find any holes below the current hole, it
begins looking for a hole in the column to the right of the current
column. The algorithm tries to move the insertion point directly to
the right of the original insertion point until it crosses the column
gutter, and then looks up and down inside the new column for line
rules or guides or text that blocks off the new hole above and below
the insertion point. It continues this process of looking for holes
below and then to the right as long as it has text left to place.

Note that any areas enclosed by box rules or guides will not be
filled by this algorithm unless the insertion point is placed inside
the box to start with. Further note that if the insertion point is
placed inside a box, no other hole can be found to place any text that
oversets the box.

Because this algorithm requires fairly extensive processing to
compose and place all the text, the user is always shown where the
text will flow before it is actually placed on the page. When
autoflow mode is turned on (through the menus) and the user indicates
an insertion point (by clicking with the mouse), the area that the
autoflow algorithm intends to place text into will be indicated with a
stipple pattern (i.e., a light grey dot pattern). If the user does
not really want to flow text into the indicated area, he may either
turn autoflow off (thereby removing the stipple pattern) or change the
area boundaries so that the stipple pattern shows the area he wants
the text to flow into.

One of the options the user has in modifying the flow area is to
move one or more of the guides that define the tops and bottoms of the
holes.,

Once the user has decided that the flow area shown by the stipple
pattern is correct, he places the actual text by choosing the "Place
text file" function, typing in the text directly, or by pasting text
from the clipboard. The "Place text file" function takes text from a
file, and is useful for putting entire stories onto the page. Typing
in the text directly is most often used for relatively short text
pieces, and the paste command is usually used for placing overset
text.

When the text the user wants placed is too large for the autoflow
area, the algorithm trails the excess text down the page below the
last line of the autoflow area. The user may choose to select the
overset text by clicking at the start of the overset portion, and then
choosing a function from the Edit menu called "Select to end." The
user may then cut this overset text either by using the "Cut" function
in the Edit menu, or by choosing the "Cut with jump report™ function.
This function brings up a dialog that allows the user to type in "jump
to" and "jump from" messages. In either case, the overset text is cut



(and thereby placed on the clipboard), and then may be pasted wherever
the user wants it to go. The paste command will also flow the text
into the area the user indicates as long as "Flow on" is still
selected on the Styles menu.

Once text has been placed into an area, the shape of that text
cannot be changed without cutting it and pasting it again, or choosing
the "Reflow text" function. (The reflow function assumes the same
insertion point for the selected text.) Any editing changes to the
text will cause the text to be recomposed, but it will maintain the
shape that it was originally poured into.

The following example (along with Figure 10) shows autoflow in
action. The user has already typed a headline onto the page, reserved
room for a photo, and typed in a caption below the photo. He now
wants to place a story he has in another file onto the page.

First, he pulls down the Styles menu and turns "Flow on." Next,
he chooses an insert point below the headline. The system responds by
placing a stipple pattern in the areas discovered by the autoflow
algorithm. The user wants the fourth column to begin at the same
level as the headline, so he moves the "cap guide"™ up for that column.

Now he is ready to place the story. He pulls down the File menu,
selects "Place text file", and chooses the name of the file that
contains the story from the dialog box. The story is placed into the
area covered by the stipple pattern. The story oversets the area a
little; the user could cut the overset portion and paste it someplace,
but decides to edit the story to fit instead. He selects a couple
excess phrases in the story and cuts them, causing the story to be
recomposed in its area. The story now fits entirely inside the area
it was flowed into.
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APPENDIX B

This appendix contains an example of how one might make up a
simple display ad using the Aldus document layout terminal. Display
ads are the most free-form of the document types that we expect users
to produce on the document layout terminal. More structured
documents, such as newsletters, put more of the text placement burden
on the computer, as was shown in Appendix A describing the autoflow
algorithm.
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Figure 1

-4 display ad featuring a grandfather clock is created in this

| »xample. The artist first selects the New document command
from the File menu and fills in the form shown above. In this
:xample, the page size is the same as the ad size (4.5 by 5).

When the size and name are entered, click the OK box
- to tell the publication tool to create the new document.
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[E==————=——— display ad erample

EMPEROR GRANDFATHER
CLOCK SHOW

The artist first enters the primary tnessage of the ad, the
headline in this case. He dosgs this by clicking at the upper left
corner of the sheet to create an edit point. The headline is
entered using the keyboard. The text could have been
entered previously into a text file and pulled over to the
sketchpad using the Place file command in the File menu.

In this case, the artist is working from a thumbnail sketch
received from the ad salestman.
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After entering the headline in the default size (12 point), the
artist now will wish t¢ increase the size. To do this, the artist
selects the headline text by dragging the peinter through it. The
text will be highlighted. Then, he pulls down the Styles menu
and selects the "Text size & line spacing”™ command.
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The artist has chosen the Adjust character size to fit function. The
publication tool will adjust both lines so that the size of the
largest line will determine the size of all other selected lines.

To tell the publication tool to go ahiead and perforin the adjust
character size to fit function, click the OK bozx. If the artist wished
to exit from this dialog without making any changes, he would
click the CANCEL box instead of the OK box.
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Figure 5

J‘ After the new size function has been called, the selected text
(the headline) is now at the desired size. The headline remains
selected until another element is selected or another mode is

entered.




EMPEROR GRANDFATHER
CLOCK SHOW

Figure 6
The artist, after entering the headline, then determines where to
place the artwork and how to place the rest of the ad. The artist
selects the rule mode by clicking the rule icon (below the arrow
icon). The headline deselects and a graphics cursor replaces the
pointer cursor. The artist draws a weightless rule (dashed line)
to delimit the area for the artwork. The artist could have also
traced the artwork using the mouse, but instead used the straight
line rule. The artist, when drawing the rule, held the shift key

down so that the rule was constrained to be either vertical or
horizontal.
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EMPEROR GRANDFATHER
CLOCK SHOW

PORTLAND SHOIWING
HEDNEESDRY thrwu SRTURDRY
February 8, 9, 10, 11
2511 N.E. S58th St.
1Block €.0f Candy Blud on 58th
PHONE: 282-1453
SPEC | AL SHOW ING AT THE HOME OF

MARK KRUKGER
Some ki ts available for pickup

........................................................................................................................................................................................
...............................................................................................................

......................................
....................

Figure 7

The artist has created a second rule, indented slightly from the
first rule, to bound the next text entered. He then selected the
pointer icon from the mode bar and selected a location to enter
more text. The text entered was varied in the face and size (boid
and 12 point) as well as justification (two lines were center
justified and the rest were left justified). The artist could have
entered each line as it was to appear in the ad or in one text
entry session and afterwards changed each line.



J File Edit Stles Tools Justifg Zoom

EMPEROR GRANDFATHER
CLOCK SHOLW)

PORTLAND SHOWING

HEDNESDRY thr’uSRTLmv
Februar 10, t1
2511 N. Ssth St.
t Block 9 of Gandy Bivwd on Seth
PHONE 28Z2-1453

CIAL SHOWING AT THE HOME OF

MARK KRUEGER
Some ki ts availeble for pickup

1P.M.TILL 9P.M.

sConpleto iy Rsmbiad @ ilesinste Chines
ad Finished Llacks @ 3plid 34 Black Malmut,
® rit-Yoursel? Cits Tharry ond Dok

@Sclid frose Hest bernmn! @ Thras*aa- Lbreanty
Novenmt and Dial

The artist has added another guide to help enter the two
columns of detail product information. The artist has also

set the hanging indent through the rulers and the Change indents
command. The ruler contains icons which represent the amount

of space to indent. The artist then entered the text in the proper
size and justified left.
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EMPEROR GRANDFATHER
CLOCK SHOW

PORTLAND SHOWING
HEDNEEDAY thru SATURDAY
February 8, 9, 10, 11
2511 N.E. 58th St.
1Block €.0f Candy Blud on BGth
PHONE: 282-1453
SPECIAL SHOWING AT THE HOME OF
MARK KRUEGER
Some kits available for pickup

1PM.TILL9P.M.

@ Conplataly Rcatilad & lestainste [hines

ad Finlshad Clocks @ 3olid 3/4° Mok Halaut,
¢ o It-Vourml ¢ Kitx Charry and Dok

@ Solid Bross st kramn @ Thraa—aa+ larranty
NHovenmt and Dial

SPECIHL SHOW PRICES
MANY MODELS ON SALE

BREREERES ISR ERBE8RRERARY

Figure 9

The artist has deleted the short guide used to bound the product
description bullets and entered the two lines "SPECIAL SHOW
PRICES® and "MANY MODELS ON SALE". These two lines were
centered between the guide and sketchpad boundary by
selecting both lines and entering the Center command in the
Justify menu. The MANY MODELS line has a different size, so
that line was selected and the new size was chosen from the
Styles menu.

Now the artist must scroll the sketchpad to continue.
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[(BP————————————— display ad example

1P.M_TILL 9P.M.

oronplasta iy Rceaiad @ Nestlinster Chimes
and finished Clacks @ Solid 3M4° Black Walnut,

® fo-itvowrsslf Kits Charry ond Dok

® Solid Brase lest beramn .Thrnihcr Lorrenty

Bovenent and Dial

SPECIRL SHOIWU PRICES
MANY MODELS ON SALE

Figure 10

To scroll, drag the screen icon over the sketchpad icon in the
scroll bar at the lower left of the screen. This will cause the
display to scroll. In this example, the artist has scrolled to the
bottom of the pad.

8888888888808 -



1P.M.TILL 9P.M. |

SConplate iy Rcodiad @ Nesainster Chimes
nda Finished Clacks ® 3ol id 3/4° Mlock Halout,

& (o-it-Yousel t Kits Charry ond Dok

® Solid frose Hect Beramn @ ThraaNeor Lbrranty

Novenant and Dial

SPECIAL SHOW PRICES

MANY MODELS ON SALE
LAYRHAY PLANAVAI LABLE

Pranpt skipment guar enteed fros cur Fairbape

Rldima, plant. See these beauti ful traditionof Esperar

Grandfother Clocks at this Setial Shoaing

Figure 11

The artist entered the new lines below the MANY MODELS line
after scrolling. Then, the LAYAWAY line was selected and

the Center command was selected from the Justify menu. The
first three words in the next line (PROMPT SHIP...) were selected
and changed 10 a bold typeface. To change the typestyle, the
artist selected the Change typestyle command from the Styles
menu and then selected the bold face from the menu of
typefaces in the command dialog.

The artist then selected the last three lines and selected the Fill
to margins command from the Justify menu. This justified the
final paragraph between the guide on the left and the ad
boundary on the right.

At this point, the artist decided to center the last line of the
paragraph. To do this, first he selected the line by stroking the
mouse cursor through the line while pressing the button. Then,
he hit the M key on the keyboard while holding down the "%’
key. This is a shortcut to the CENTER command in the JUSTIFY
menu. These two actions centered the last line.
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1P.M.TILLOP.M,

SConpletaly Axutiiecd @ Kestninster Dhines
ad Finished Clacks e 3plid 3/4° iak Haleut,
& Do-It-Yoursel T Kits Cherry ond Dok

# Solid Brass Hest Sarnon @ Throe-Naa arrenty
NHovement end Dial

SPECIAL SHOIWU PRICES

MANY MODELS ON SALE
LAYALIARY PLANARVARI LABLE

Pronp t shipment guor enterd fron our Fai rbape

Rlchona, plant. See these teauti ful traditional Esperar

Grendfother Clocks at this Special Shoning

.........................
...............

The artist has created a boxed rule by selecting the box icon
from the mode bar on the left, selecting the desired rule weight
from the Styles menu and drawing the boxed rule. The box is
drawn by centering the graphics cursor (cross), pressing the
mouse button and dragging the mouse until a box of the

desired shape has been formed on the screen. If exact sizes are

IR ABRRREERERABEHERERRRARBRES

Figure 12

needed, the rulers may be used.
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Mode! 475

1P.M.TILLOP.M.

oConpletaiy Aceblad @ Nestainste Chimes

ad Fintshed Clocks e 30lid 34" ek Halmt,
® Do-It-Vouss! f Kits

Charery ond Dok
@ Solid rose Hest raon .Thrﬁbo torranty
Novensnt end Dial

SPECIAL SHOW! PRICES

MANY MODELS ON SALE
LAYRUAY PLANRURI LABLE
PAronp t shipmen t guar entead fron cur Fairhope
Ridbona, plant. See these teauti ful traditiona! Esperar
Grsndfoather Clocks at this Special Soning

MORLD FANOUS EMPEROR CLOCKS ASSEEN ON T. U]

0D x 24400 13%° 1D

Hrite ForFree Color Catalog

GRB{RBREEH

The artist has now added a weightless boxed rules to reserve
space for the logo and credit card artwork. Finally, he added
the model information for the grandfather clock artwork.

After doing this, the artist can add a rule around the boundary
of the desired weight (this may be done at any time during the

........................................................................................................................................................................................
....................................................................................................

makeup of the aqd).

E




EMPEROR GRANDFATHER
CLOCK SHOW

PORTLAND SHOLWING
LEDNECDRY thru SATURDAY
February 8, @, 10, 11
2511 N.E. 58th St.
1Block €.0f Sandy Blud on 52th

PHONE: 282-1453
SPEC AL SHOWING AT THE HOHE OF

MARK KFUEGER
Somakitz ounilobla for pickup

1PM.TILLO9P M.

eConplataly Rcaitiiad @ Nestinster Chimes
ad Finished tlocks ® 30lid 34" Black Halnut,
® o-itVousmif Kits Charry and Dok

@ Golid Bross Huct Gernan @ Thraa-‘lao~ lbrranty
Novenmt and Dial

SPECIAL SHOW PRICES
MANY MODELS ON SALE
LAYARKWAY PLANAVAT LABLE
Pronpt shipmen t guar enteed fron cur Fairhope

Rlchona, plont. See these beauti ful traditional Exparar
Grondfother Clodis at thhis Special Shoning

RORLD FAHOUS EMPERDR CLOCKS RS SEEN ON T.U.J

HriteForFree Color Catalog

Figure 15

This is the first draft from the Mac Imagewriter. The artist may

use this as a check that the clip art and text work together.
The artist will discover, using this draft copy of the ad, that the

clock artwork is too tall to fit between the second line of the
headline and the model number. The artist now must go back and
change the layout so that the artwork will fit.
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EMPEROR GRANDFATHER
~CLOCK SHOW

PORTLAND SHOWING
HEDNEEDAY theu SRTURDAY
F 8, 9, 10, 11

2511 N.E. 38th St.
1 Rlock €.0f Sandy Blwd on BQth
PHONE: 28Z-1453
SPEC 1AL SHOUING RT THE HOME OF
MARK KRUEGER
Some ki ts avai lable for pickup

1P.M.TILL9P.M.

SConplata iy Rcnalilad wigstRinstee Chims
ad Finishet Clocks @ Solid 3/4° Block Walnut,
® - it-Voursal f Cite Charry and Dok
aGolid fross Hast krnon @ Thrae-ao Uborranty
Novenmt and Dial

Figure 16

First, the artist scrolled back to the top of the ad and returned
to the pointer mode. He then built a select box around the last
line of the headline (CLOCK SHOW). The artist then moved the
line horizontally by moving the pointer to the side of the box
and, while holding the shift key down, dragged the mouse. The
move was constrained to the horizontal direction because the
shift key was held down during dragging.

This corrected the layout by moving the headline so that there
would be room for the grandfather clock artwork.



EMPEROR GRANDFATHER
CLOCK SHOW

PORTLAND SHOIDING

HEDNESDAY thru SRTURDAY

F 8, 9, 10, 11
2511 N.E. 58th St.
tElock S.0f € Blud on 59th

PHONE: 282-1453

SPECIAL SHOW I N0 AT THE HOHE OF
MARK KRUEGER

Soma ki ts ouailabla for pickup

1PM. TILLO9P M.

eConplastaliy Rxestiiad @ HNesteinster Chines

awd Finished Clocks o 3olid 3/4* Block talnut,
® o ItYoursalt Kits Chorry and Dok

® Solid frass Hact frnen @ Three-na Uorranty
NHovenent ond Dial

SPECIAL SHOWL PRICES
MANY MODELS ON SALE
LAVRHAY PLANAVAI LABLE
Aranp t shipmen t guor enteed fronourFairbape
Rlaboma, plont . See thesa beauti ful traditional Esperar
Grandfather Clodks at this Sperial Shoning

HORLD FAHOUS ENPEROR CLOCKS RSSEEN ON T.V. |

fade! 475
A M5 U 3D

Hrite ForFree Color Catalog

Figure 17

This is the final draft from the Mac imagewriter. Notice that
the guides are still printed. The guides would be eliminated
when the ad is sent to a typesetter.



EMPEBDR GRANDFATHER

. CLOCK SHOW_

X e S o et g W i sl Sl TS

POHTLKHD CHOWING
WEDNESDAY thru SATURDAY
February 8, 9, 10, 11
2511N. 58th St. :
1 Block S. of Sandy Bivd. on 58th
PHONE: 282-1453 . .
SPECIAL SHOWING AT THE HOME OF .*

MARK KRUEGER
«  Some kits available for pi

1 PM.TILL9 PM

. Completely Assembled ¢ Westminster Chimes

and Finished Clocks * o Solid 3/4" Black Walnut,

‘. e Do-It-Yourself Kits Cherry and Oak

* Solid Brass West German e Three-Year Warranty
Movement and Dial

SPECIAL SHOW PRICES

MANY MODELS ON SALE
LAYAWAY PLAN AVAILABLE

PROMPT SHIPMENT GUARANTEED from our Fairhope,
Alabama, plant. See these beautiful traditional Emperor
‘Grandfather Ciocks at this Special Showing.

{ WORLD FAMOUS EMPEROR CLOCKS AS SEEN ON T.V. |

79"(H) x W(W)vx 1?%“(0). EMPERORP .

=

CLOCK COMPANY
WORLD'S umsesr MANUFACTURER
OF GRANDFATHER CLOCKS

. rmm AL 20832
‘Write For Free Color Cawog
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